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CAD Portion of the Program 
 

New Open / Preview Dialog 
 
One frustrating thing about using the Cimex Preview option in the open dialog, was that each time you 
needed to change folders, you had to escape out of the preview to get back to the Open Dialog, then 
change folders, then go back to Preview to see the Preview screen again. For Version 15 we spent a lot of 
time creating a totally new dialog which combines the two, so that you can have one screen where you 
can change folders, but also have a Preview of the files maintained at the same time. 
 

 
 
As you can see, the optional folder tree is on the left side of the screen, and then the preview window in 
the middle. The right menu offers all the different controls, some of which we had before, but also some 
new ones. Back with version 14.1 we started saving a product type with every file, so that if you 
programmed a dieboard as opposed to a stripping board, the file was labeled as such. Although we 
weren’t doing a lot with that information in version 14.1, we knew we were going to make changes to 
how we opened files, so wanted to start having the files labeled appropriately.  The idea was that we 
wanted to be able to allow you to go and say I want to open a file, but I only want to see dieboards, or I 
only want to see single designs not layouts, or only phenolic counters. 
 
Version 15 now has that capability, where you can change the area labeled “All Products” on the right. 
 



Here you can see some of the products that you can pick from, so once you select one of those the 
preview window will change to only show files of that product type. 
 

 
 
Also new in this dialog is a File Modified option, where you can control which files you see based on 
when they were modified etc. 
 

 
 
There is also a Favorites option, so that you can choose between all the favorite locations that you 
customized and added to the regular Open Dialog. Although this new dialog is the default, you can get at 
the old Open Dialog and method if you prefer.  However, this new option does a lot of different things 
that previously required you to go to multiple places to get at. If you want to type a specific filename you 



can do that in the area where you can see “file name (e.g. abc*), or add a template like abc* which would 
then display only files starting with the characters “abc”. 
 
Also, as in the regular Open Dialog, you can change the file type being shown so just seeing the relevant 
files. This same dialog is therefore used when you go to File > Import as well as File > Open, so that even 
if you set your file type to DXF, you would then see previews of the DXF files just as you do with Cimex 
“CIM” files. 
 

 
 
All sorts of changes were made to the program in the background to make all of this possible. 
 

Importing Different File Formats 
 
It used to be that some of the imported file types allowed you to have some type of linetype mapping. We 
have now standardized on the same mapping procedure for all the major imported file formats.  If you 
have multiple map files for the same file format, you will get prompted for the one to use. 
 

 
 
 



If you are importing a file that has un-mapped linetypes, you are told, and given the option of mapping 
them to a linetype in CimPACK. 
 

 
 
If you elect to map the linetypes, one by one they are highlighted on screen, and you are taken into the 
standard linetype dialog to pick the appropriate CimPACK linetype to use for the un-mapped linetype 
from the file. Once all of the linetypes have been cycled through, you get options on what to do. 
 

 
 
You can update the original map file that you were using, or you can have the mapping saved to a new 
map file, or you can elect to just make the changes temporary. You can therefore create as many different 
map files as are necessary, and therefore deal with all sorts of different files coming from various sources. 
 
The PDF Import option was updated and improved, and is also one of the new file formats that supports 
user-defined linetype mappings. 
 
We now support AutoCAD file versions 9 through 2013. 
 
Most of the file imports and exports now run a lot faster than in previous versions, as now built into the 
main program rather than external programs. 



Behind the Scenes  
 
Continuing again on the trend of the last several versions, we added some more engine improvements to 
speed up some common actions and to streamline various tasks, improving the general speed and 
responsiveness of the software.  
 
We made some fairly large technical changes to the software to make transferring files between different 
countries and languages much more seamless. Sending a file from Japan to Taiwan or China or America 
could cause problems, as could exchanging a file originating on a Spanish language system with an 
English language system. As everything gets more and more international these days, this becomes more 
and more of an issue. 
 

Windows 7 / 8 
 
Version 15.x of CimCAD / CimPACK is Windows 7 / 8 compatible. 
 

Miscellaneous  
 
It used to be that one could convert circles to four 90 degree arcs, mainly for laser purposes. A new option 
was added that allows either arcs or circles to be converted to equal length segments, however now the 
number of segments is prompted for. 
 
An option was added to Modify called “Square Off Slot End”, which basically does the opposite of 
“Blend 3 Lines”, as switches a rounded off slot end to a squared off slot end. 
 
The First Aid Dialog now supports the use of a user defined macro which could be written to perform 
whatever custom checks are needed, it looks for a macro called “FirstAid Custom.mac” and if present 
enables the option. 
 
Dimensions are now kept when you add a form. 
 
It used to be that when you scrolled your middle mouse button, the image on screen zoomed in and out 
based on the center of the screen. However, there is now a configuration option so that rather than using 
the center of the screen to zoom from, you can have the current cursor position used instead. 



CimPACK Portion of the Program 

 

Rotary 
 
The Rotary Calculator was changed to also support degrees, so for example you can get the degrees on a 
Serrapid print as a linear dimension instead of just 3.5 degrees on whichever plane. 
 

 
 
As well as adding rotary bolthole labels, there is now an option to delete them so they can be redone. 
 
For the combination CL/LE marks in rotary marks and designations, you can now have symbols used 
instead of simple text, which are basically easier to read and look nicer, but take longer to etch as outline 
text for example. 
 
When changing rotary boltholes to lasercut slots, the size of the slot now compensates so that the size of 
the slot you give is what you want at the base of the countersink / washer, so will expand out to the CAD 
plane depending on the cylinder diameter. An extra plane was also added to the rotary calculator, this new 
countersink / washer base. This gives much better control over the size of the ovals for washer support. 



 
 
Martin Posilock patterns now shift shell patterns so the horizontal seams are between bolt rows 
automatically. Also, there is now a configuration for the types of holes to mount the hoops with, whether 
they should be all circles, all ovals, or a combination. The oval holes will remain as is unless this option is 
configured. 
 
The Rotary Bolt main dialog now has quick options to change the bolt step in the X from  2 or 3 inches, 
or 50 / 75 mm depending on whether imperial or metric cylinders. 
 
Two additional crease linetypes were added to CimPACK, a Surface Mount Reverse Score, and Twin 
Score. By default these linetypes etch in the die as in both cases it is not the line itself that creates the 
crease, but what is mounted there. 
 
A configuration parameter was added that controls whether small corners like those on rotary Legard re-
enforcers are burned as a corner or as a simple radius. 
 
When doing a rotary auto bridging on all horizontal / vertical ruled lines, Legards are now ignored. 
 
The rotary seam option for using a new sketched seam was redone to support more situations, but is still 
just for a 2 shell design. 
 
An option for designating Critical Bolts was added to the boltholes menu, so special bolts can have etched 
marks highlighting them. 
 
The Rotary Reverse Score option in marks and designations now also etches on the color of the score. 



 
The Serrapid mushroom options menu now has an option for a partial mushroom on the sides for Option 3 
dies. 
 
Rotary V-Slots are now configurable in preferences. 
 
A new rotary slot manipulation option was added to change slots in a design. You can set three ranges of 
slot sizes, and then whether the slots are to be square or angled or round, or left alone. You can then click 
inside each slot you want to change. 
 

 
 
Additional rotary cylinders were added as follows – 

Isowa Ibis 50 
Latitude 27 
Ward 50 Serrapid SR3 
Ward 75 Serrapid SR2 
Emba 245 QS Serrapid SR3 
Gopfert 66 SR3 (Option 2 with asymmetrical mushrooms) 



Rotary : Mitsubishi Evol 
 
The Mitsubishi Evol Independent Pins now have an option to automatically add the perf segments when 
adding the pins, if you only want one side of the perf  just delete the other. There is also a checkbox to 
automatically add the color symbol that will be etched into the die like "Y" for yellow, you just get to 
drag the symbol to the desired location. 

 
Improvements were made to the lifters so they can be added to more design shapes. 
 
When adding Mitsubishi lifters, there is now an option to leave the lifter profiles as is, so it is then not cut 
to the knife profile, and can then be moved as needed. There is also now an option to have the lifter 
profile slid until it is a set distance away from the knife, so that the lifter is left complete, just not hitting 
at exactly the center of the hole. If the lifter is the pre-slotted TK007A/B style, then perf is automatically 
added to the lifter also. 

 



The Mitsubishi Lifters Menu now has an option to toggle the mount etch lines between construction and 
non construction. 
 

Rotary :Ward Pin Stripper 
 
It’s back. Support was added for a Ward Pin Stripper, for the 50 inch version at this point. Various shapes 
were added to help speed up the design process, along with quick access to construction lines. Once the 
pins are added to the die, the pin stripper die is automatically created as a separate file. 

 
 

Stripping Boards 
 
The board size dialog for male stripping boards now allows a minus 20mm option on the custom Y size, 
basically working the same way as the minus 20mm option on the standard press size Y size. 
 
The internal portion of a constructed female stripping board support rail is now completely filled, not just 
the dovetails, so stands out more. 
 
In windows protrusions / chamfers in female stripping boards, the claw/tab folding carton combination 
now has a mini version, a smaller version for tighter areas, so basically utilizing an 8mm wide tab instead 
of a 12mm tab. 
 
In Female Stripping Boards, the chamfer with pin option now automatically creates an avoidance zone 
around the standard pin, so that the wooden block is cut back there. It basically works like the avoidance 
on the claw, just that the pin to use is fixed. 
 
Stripping Boards and Guillotines were all changed to run gaps up to .005, so standardized  / the same 
now, used to be either .003 or .004 for gaps tolerance. 



The regular style stripping claws all had the end of the "L" cut extended by 2mm. This gets around the 
issue that some suppliers make the base of the claws one length, while from others it is longer. The 
combination tab/claw combo files were also changed. 
 
The Auto Find window in stripping boards now has an option to turn off the regular auto-copy feature, so 
makes it easier to pick some but not all possible windows to strip in some situations. 
 
The Male Stripping Board pins / rule menu now offers some standard widths of wave rule as an additional 
stripping method. References lines and text are automatically added to show the overall widths of the rule 
as just on a 3 point base. 
 
When adding tabs in the FSB program, the "+opposite" option was improved so works better when 
working on the outside edges of a stripping board. 
 
When adding labels to constructed rails in female stripping boards, the label text is now automatically 
moved to the front of the rail if it is one of the short rails, but left at the back for the wider ones. 
 

Ejection Rubber 
 
Some improvements were made to rubber to deal with gaps on regular inside panels. Ejection Rubber now 
has an option to delete all pieces, so an easy restart if you want to re-run panels with different settings. 
Also, in the automatic panels option there is now a configurable third type of rubber there for doing just 
the outside pieces, and internal that is waste. 
 

 
 



An additional offset was added to ejection rubber for the trail edge, mainly for rotary work. You can then 
have a large offset on the rear of any shape that is done as a Window, so for pieces that will get "shunted" 
around the cylinder. Also, an additional shape was added for chopped scrap areas like the below, creating 
a “U” instead of the full rectangle. 
 

 
The rubber sheet configuration menu now also sets the default width and offset for each type of rubber, 
and whether spacer tabs are to be added. Also, 45 additional new rubber types are  supported here, 
linetypes 700-745. 
 

 



Rubber spacer tabs are now also accessible in the second page of options, and when deleting spacer tabs, 
undo is now supported. An additional tab style was also added, much wider triangles spaced further apart. 
 
When going into the rubber layout option for the first time, you no longer have to pick automatic 
arranging as picked automatically, however if go back to arranging you then get the full menu of options. 
 
The RubberSquareInches forms macro was changed to look for multiple rectangles in the "Rubber_edge" 
section and if found use those added together one by one rather than the overall size of all the rectangles 
together as a group. 
 

Blankers 
 
The main blanker program now allows you to use components available from VTD, so from either the 
"Laserform" or the "Formix" family, so will then add the different frame and joggers / fixing brackets etc. 
In the beginning of the blanker, you are asked which set of components you are going to use. 
 

 
 
When adding buttons in the male blankers routine, the horizontal and the vertical radio buttons used for 
the presser bar section now also apply to the buttons. 
 
Some additional bar widths were added to the blanker bar width options. 
 
The Male Blanker Program now supports both the Marbach and the Cito small individual button pressers. 



Phenolic / Steel Counters 
 
In the Multi-Pass option in Phenolic Counters you can now specify a minimum overlap amount for the 
crease channels, so can be increased if you are having issues with the base of the channel not being 
smooth enough. 

 
 
Phenolic counters now has an option for adding peel off tabs to the TOOL4 profile, which are  there to 
make it easier to peel the sticky backing off the counter. 
 

 
 
An additional steel thinplate design was added to the steel counter menu, the Bobst SP126. 



Designer Module 
 
An additional form field was added WOODSIZE, which adds the board size for various products 
including blankers and stripping boards, not just the dieboard size. 
 
Two additional form fields were added for single design areas, one giving just the internal scrap areas, 
and one the surface area of the design so the full area minus that of the internal scrap. Various additional 
sheet usage options were also added such as just the outside trim strip, and also the surface area of the 
design. Options were also added to show the design size in square units rather than an X x Y size, and 
also for the sheet size. 
 
An additional waste / area option was added to CimPACK which can work better on some types of 
layouts. 
 
The seven folding carton filter standards that use fingered pleats now also prompt for the number of 
fingers / pleats to add, so can be changed. Also, an additional filter standard was added to a new sixth 
page. 
 
An additional folding carton bag standard was added. 
 
Two additional folding carton tray standards were added. 
 
Two standards were added to the new folding carton Multi-Piece Box heading. 
 
Some improvements were made to the Auto Dimension option to work on more cases. 
 
An additional folding carton gift standard was added. 
 
There is now a Form Cleanup routine on the second page of the CimPACK Utilities menu to clean up 
remaining forms sections and check for a design rescale. 
 
The cutcrease menu now allows you to change the hashmark length for all the options, especially for 
wider rule widths, and also whether or not hashmarks are to be added in the first place. 
 
An additional cutcrease style was added, where you give the cut and crease lengths, and the fixed land 
lengths at the ends. The length of the cuts and creases is then scaled to force the correct land lengths. 
 
Both the printing bleeds and side bevel menus now have the offsets configurable on the menu so not 
prompted for each time. 
 
Cutcrease now has an option to either create the individual lines as it currently works, or to create a single 
cutcrease line with all the hashmarks denoting where the cuts and creases terminate. 
 
Dimensions now has an option for adding XY size dimensions to all the areas of ruled lines found, so if a 
box has multiple portions that make it up, you don't have to select each portion one at a time to add the 
sizes to them. 



Miscellaneous 
 
Support was added for the new Bobst SPO machines such as the Expertcut and Mastercuts. This also 
included things like the new options in the front separators to add vacuum holes, and openings on the die 
edge for the optional print register units. 
 

 
 
In Preferences one used to have control over bridging on straight lines, and bridging on arcs, now circles 
were added as a third configurable option. 
 

A Bisect Point-Point option was added to the nicks start point menu. 
 
Both the regular and the multiple versions of vector text names were changed to allow ten lines of names 
rather than five. The "#" symbol in full cut vector text names was changed to tack in the center of the 
hash, and the full cut names now also support the "&" symbol. 
 
The Kluge Kawahara now uses filled colors to more clearly show the pins. 
 
The Layout Die Options Menu now has an option for adding station numbers to all the cartons in the 
LAYOUT section, so can correspond to numbers printed on the sheet. The order of the numbers can be 
controlled using Layouts > Create > Reorder. 
 
Both flat and rotary punches now show you the actual punch when giving the positions for them. 
 
The Router Module was changed to allow the tight and loose pointages to be selected and mapped. The 
Router Configuration menu now has an option for configuring the alignment pins, where the diameter of 
the pins and the offset from the design edge can be set. 
 



The quick dimensions in the Dieboard Edge Menu can be configured to be on the trail and right rather 
than the lead and left. 
 
Handles now have a configuration parameter to ignore stripping rules when deciding if there is room for a 
handle on each side. 
 
Support was added for some older Wupa diecutters in the die edge menu. 
 
The Flat Die Quoting program now has an option to use a combination of the blank size and machining 
length to specify the price of a phenolic counter, as opposed to using a fixed price. 
 
Tackbridges on circles are now special cased so the tacks are correctly spaced by equal distances. 



DOS / Windows 95 / Windows ME / Windows 98 / and 

Windows 2000 

 
Versions 15.x  / 14.x do NOT support Windows 2000, so require Windows XP at a minimum. 
 
When it comes to DOS, it is now well over 10 years since we went to a Windows platform. Apart from 
the fact that we basically can’t remember how to run the DOS version of CimCAD / CimPACK, almost 
none of the hardware in our office will even run the DOS version anymore. As such, we have no choice 
but to stop support for the DOS version, we are no longer capable of offering any effective support for it. 
We would encourage anyone still running DOS to take the plunge and upgrade their hardware and 
software. The activators for 15 are also incompatible with DOS, just another example of new hardware 
basically being Windows only. 
 
Thanks 
 
 

Notice to CimCAD / CimPACK Customers Upgrading from a 

version earlier than Version 11.0 (such as. 10.4) 
 
Changes made to the Version 11.0 release shipped in July 2004 mean that if you have written any custom 
software, changes may be required. If that is the case and you need us to train you on the differences with 
11.0 please contact us for a quote on that.  
 
If you are upgrading from any 11.x version to 15.x there are no changes required, but if upgrading from 
Windows 10.4 to 15.x for example, then this applies to you. 
 
If you paid us to write custom software for you, it may need some work done on it to function correctly in 
the new version. 
 
Standard Laser Drivers and Router Maps supplied by Cimex will be converted free of charge, however 
means that we need a copy of your complete Local folder (including all sub-folders etc.) to convert, 
before we can ship your upgrade. 
 
If you have any question on this, please contact us.  
 
Thanks 
 
 



CimPACK Version 15.0 Windows Edition Upgrade Pricing 
 
 

 

From 
Windows 
Version 

Current 
V14.1 

Version 
14.0 

Any 
V13 

Any 
V12 

Any 
V11 

Any 
V10 

first user $900 $1100 $1500 $1800 $2100 $2400 
additional 

users 
$175 per $200 per $225 per $250 per $300 per $350 per 

 

From 
DOS 

Versions 

Any 
Version 

first user $2700 

additional 
users 

$500 per 

 

 

To order the Windows upgrade, please fill out the attached order sheet and either mail or fax it to us.  
 

*** Version 15 only runs on a new type of USB key we have switched to, so anyone 

upgrading to 15 from any version of 11 or earlier needs new activators. Even if you 

currently have USB keys, we are now using a newer version of those USB keys, they 

look similar but are about ½ inch shorter than the original ones. Parallel keys have 

been phased out, as have activators that run DOS, these new keys will run Windows 

only. The older USB keys no longer used are the HASP4 keys, the newer ones for 12.1 

onwards are the HASP SRM keys. If unsure you can go to Help > About CimPACK, 

and next to the “Activator :” entry it says which type of USB key you are currently 

using.*** 

 

*** We can ship new replacement activators providing a purchase order is issued. The 

purchase order will cover the additional seats of software should the old activators not 

be returned within 30 days from the  update. (Subject to credit approval)  *** 

 

*** The activator registration forms must be filled in by the end user and faxed back 

before we can ship any software. The activator registration form provides the 

necessary information needed for us to program the activators with your license 

information.  *** 

 



 

  

 

CimPACK Version 15.0 Windows Edition Update Form 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Current version of CimPACK ____________________ 
 

 Number of users  ____________________ 
 

 PO Number being used  ____________________ 
 (terms are net 30) 
 

We wish to purchase the following: 
CimPACK Version 15.0 Update   $______________ 
 

Replacement USB activators @ $65 each   $______________ 
 

Please check off the shipping method that you would prefer. 
UPS Ground _____________ 
UPS Blue 2 Day _____________ 
UPS Orange 3 Day _____________ 
UPS Red Next Day  _____________ 
 
 
Authorized Signature _______________________________  Date _________________________ 
 
 

Printed Name _____________________________________  Title _________________________ 

Cimex Corporation 
80 Daniel Shays Highway 
Belchertown, MA  01007 
Phone: 413-323-1090 
Fax: 413-323-1096 
www.cimexcorp.com 

 

Company Name _________________________________________________________________________________ 

 

Contact Person __________________________________________________________________________________ 

 

Address ________________________________________________________________________________________ 

 
________________________________________________________________________________________________ 
 

City / State / Zip ________________________________________________________________________________ 

 

Phone Number _________________________________________________________________________________ 

 

Fax Number ___________________________________________________________________________________ 

 

Email Address _________________________________________________________________________________ 


